Public Abstract Request System (PARS)
Table of Contents

PUBLIC ABSTRACT REQUEST SYSTEM OVERVIEW .................................................. 1
SYSTEM REQUIREMENTS ......................................................................................... 3
ADobe READER SETTINGS ......................................................................................... 4
  Internet Explorer 8 and later ................................................................................. 4
  Google Chrome ...................................................................................................... 7
  Mozilla Firefox ....................................................................................................... 8
  Apple Safari ........................................................................................................... 9
Problems Reading Adobe PDF files ........................................................................ 13
Adobe Reader Support Resources ........................................................................... 13
FIRST TIME USERS ................................................................................................. 14
LOG IN ..................................................................................................................... 15
  Password Problems: ............................................................................................. 16
ACH MAINTENANCE  (BANK ACCOUNT INFO) ..................................................... 19
  Adding an Additional Bank Account ................................................................. 23
  Bank Account Changes ......................................................................................... 25
    Select primary account ...................................................................................... 25
  Remove Bank Account .......................................................................................... 26
  View Transaction History ..................................................................................... 28
  Transaction Audit Report ....................................................................................... 30
DMV ABSTRACT REQUESTS .................................................................................... 32
  Driver or Vehicle Abstracts .................................................................................. 33
    Order a Driver Abstract ....................................................................................... 34
    Order a Vehicle Abstract .................................................................................... 36
EMPLOYER NOTIFICATION PROGRAM OVERVIEW ............................................ 41
  What Triggers Employer Notifications? ............................................................... 41
  Triggers Related to Fed Med ............................................................................... 42
EMPLOYER NOTIFICATION PROGRAM ............................................................... 43
  Employee Enrollment ............................................................................................ 45
    Add Employee to Notification List ...................................................................... 46
    Remove Employee from Notification List .......................................................... 50
    View List of all Employees Enrolled ................................................................. 52
PUBLIC ABSTRACT REQUEST SYSTEM OVERVIEW

PARS is a secure online service that allows authorized account holders to receive driver and/or vehicle record abstracts quickly and easily using the Web. Participants have instant access to DMV abstracts delivered via Portable Document Format (PDF) images. Typical account holders include insurance companies, attorneys, towing companies, transport businesses and other large volume requesters.

Wisconsin recently entered into an agreement with Wisconsin Interactive Network LLC (WIN) to develop Wisconsin's new eGovernment portal. Access to PARS will be through our DMV data portal provided by Wisconsin Interactive Network LLC. The contract and user agreements will continue to be between the DMV and your organization. Wisconsin Interactive Network LLC will now administer those agreements on behalf of DMV.

System Availability:
Access to PARS is available 24 hours a day. WIN support staff is available to help with on-line system and application problems.

Phone:   (608) 250-4606 Between 8 – 4 pm Monday through Friday
Email:   wi_helpdesk@egov.com
Web:   www.portal.wi.gov/register/

Fees:
The requester is charged $5 for each abstract search that is initiated. The fee applies to the search and not to the result. For instance, if your search results in a response of "no customer match", you will still be charged a $5 search fee.

Billing:
Fees are automatically debited by electronic funds transfer using the Automated Clearing House (ACH) system. Once enrolled, authorized users will need to enter bank account information into PARS to setup their ACH account. Please consult your financial institution before entering the routing and account numbers to ensure accuracy.

What is ACH:
The Automated Clearing House (ACH) system is a secure, private network that connects banks to one another by way of the Federal Reserve Board or other ACH operators. This network enables secure electronic payments to be processed.

Contract:
Applicants must sign a PARS data access agreement. The agreement will expire approximately four years from initial enrollment. A specific expiration date will be provided at the time of authorization. It is not required to continue with PARS for the entire four years; length of participation within the contract period is up to the participant.
User Access:
A completed MV3758 User Access Request form must be submitted whenever a new user is added or an authorized user is deleted.

Current criminal background checks (no older than 6 months) must be submitted with the MV3758 form.
- If you are located in the state of Wisconsin, you are required to use the Wisconsin Department of Justice to run criminal background checks. You must keep a copy of the results on file in your office.
- If you reside outside of Wisconsin, any accredited background check provider can be used.

Contact WIN:
Contact WIN for assistance with PARS accounts, and any account updates. Account updates may include: changes to your email address, phone number, agreement coordinator, adding or deleting users, individual user permissions, etc.

Phone: (608) 250-4606 Between 8 – 4 pm Monday through Friday
Email: wi_helpdesk@egov.com
Web: www.portal.wi.gov/register/

Note: You will need to contact WIN if the individual who signed the PARS Contract has left your agency.

Contact DMV:
Questions on Driver Records: 608-266-2353
Questions on Vehicle Records: 608-261-2583
Questions on FED MED: 608-267-2290
SYSTEM REQUIREMENTS

The Wisconsin Department of Transportation is unable to provide software or hardware support for non-state owned equipment. Additionally, due to the nature of the Internet, we cannot ensure your connection to state owned resources over public and private networks.

Network requirements – Internet connectivity
To access the application, a connection to the Internet is required.

Firewall and proxy configuration
WisDOT does not provide support for other organization's infrastructure components, including the diagnosis and configuration of firewalls, proxy servers, etc. WisDOT cannot assume any liability for problems or outages that may occur either directly or indirectly related to infrastructure configuration and support issues.

- Using a color printer is recommended but not required. Non-color printers will show colored entries in shades of gray.

Note: The Public Driver Abstract System times out after a non-use period of about 15 minutes. If this occurs, simply log on to PARS again.
ADOBE READER SETTINGS

In order to use PARS correctly, you will need to make sure that your ADOBE Reader Settings are properly set up.

When you click a PDF link on a web page, it can open either within the web browser or directly in Acrobat or Reader. Each browser has its own settings to control how PDFs open from a web page. Acrobat XI and Reader XI do not include a preference setting to open web-based PDFs. To change the display behavior, follow the instructions below for your browser, or see the browser documentation on how to control plug-ins or add-ons.

Adobe PDF files are identified by an icon 🔗.

Internet Explorer 8 and later

1. Open Internet Explorer, and choose Tools > Manage Add-ons.

2. Under Add-on Types, select Toolbars And Extensions.

<table>
<thead>
<tr>
<th>Name</th>
<th>Publisher</th>
<th>Status</th>
<th>File date</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Systems Incorporated</td>
<td>Adobe Systems Incorpor...</td>
<td>Enabled</td>
<td>2/5/2015 9:00 PM</td>
<td>16.0.8.305</td>
</tr>
<tr>
<td>Shockwave Flash Object</td>
<td>Adobe Systems Incorpor...</td>
<td>Enabled</td>
<td>2/5/2015 9:00 PM</td>
<td>16.0.8.305</td>
</tr>
<tr>
<td>Microsoft Corporation</td>
<td>Microsoft Corporation</td>
<td>Enabled</td>
<td>7/27/2011 4:53 AM</td>
<td>12.0.606.0</td>
</tr>
<tr>
<td>Not Available</td>
<td>Not Available</td>
<td>Enabled</td>
<td>6.1.700.117...</td>
<td></td>
</tr>
<tr>
<td>Research</td>
<td>Not Available</td>
<td>Enabled</td>
<td>6.1.700.117...</td>
<td></td>
</tr>
<tr>
<td>Discuss</td>
<td>Not Available</td>
<td>Enabled</td>
<td>6.1.700.117...</td>
<td></td>
</tr>
<tr>
<td>Sun Microsystems, Inc.</td>
<td>Sun Microsystems, Inc.</td>
<td>Enabled</td>
<td>11/25/2014 10:00 PM</td>
<td>6.0.310.5</td>
</tr>
<tr>
<td>Java(tm) Plug-In SSV Helper</td>
<td>Sun Microsystems, Inc.</td>
<td>Enabled</td>
<td>11/25/2014 10:00 PM</td>
<td>6.0.310.5</td>
</tr>
<tr>
<td>Java(tm) Plug-In 2 SSV Helper</td>
<td>Sun Microsystems, Inc.</td>
<td>Enabled</td>
<td>11/25/2014 10:00 PM</td>
<td>6.0.310.5</td>
</tr>
<tr>
<td>Symantec Corporation</td>
<td>Symantec Corporation</td>
<td>Disabled</td>
<td>3/4/2013 10:27 AM</td>
<td>11.1.0.0</td>
</tr>
</tbody>
</table>
3. In the Show menu, select All Add-ons.

4. In the list of add-ons, select Adobe PDF Reader.
5. Click the Disable button (it toggles depending on the status of the selected add-on):

   Enable sets the Adobe PDF Reader add-on to open PDFs in the browser.

   Disable turns off the add-on so it does not open PDFs in the browser.

6. Click on Close, and then close all Internet Programs and restart your computer.
Google Chrome

1. Open Chrome, and go to: chrome://plugins

   Plug-ins

<table>
<thead>
<tr>
<th>Plug-in Name</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widowsve Content Decryption Module</td>
<td>1.4.3.671</td>
<td>Enables Widevine licenses for playback of HTML audio/video content.</td>
</tr>
<tr>
<td>Adobe Flash Player 2 (flash)</td>
<td>Version 16.0.0.173</td>
<td>Adobe Flash Player 14.0.0.173</td>
</tr>
<tr>
<td>Chrome PDF Viewer</td>
<td></td>
<td>Chrome PDF Viewer</td>
</tr>
<tr>
<td>Chrome Remote Desktop Viewer</td>
<td></td>
<td>This plugin allows you to securely access other computers that have been shared with you. To use this plugin you must first install the Chrome Remote Desktop webapp.</td>
</tr>
<tr>
<td>Native Client</td>
<td></td>
<td>Native Client</td>
</tr>
<tr>
<td>Silverlight</td>
<td>Version 5.1.30214.0</td>
<td>Silverlight</td>
</tr>
</tbody>
</table>

2. Locate the Adobe PDF plug-in, and do one of the following:

   - To have the Adobe PDF plug-in open PDFs in the browser, click Enable.
   - To use the Chrome PDF Viewer instead of the Adobe PDF viewer, click Disable for the Adobe PDF viewer. The Chrome PDF Viewer becomes enabled.
   - To have Chrome download PDFs instead of displaying them in the browser, shift-click Disable for the currently enabled viewer. This leaves both viewer plug-ins disabled so the PDFs won't display in the browser.

3. For more information, see the Google Chrome help topic Plug-ins
Mozilla Firefox

2. In the Add-ons Manager window, click the Plugins tab, then select the Acrobat or Reader plugin.
3. Click the Enable or Disable button (it toggles depending on the status of the selected add-on):
   - Enable sets plugin to open PDFs in the browser.
   - Disable turns off the plugin so it does not open PDFs in the browser.

4. For more information, see the Mozilla Firefox help topic Using a PDF Reader Plug-in.
Apple Safari

Make Acrobat or Reader the default viewer for PDFs
1. In the Finder, select a PDF, and choose File > Get Info.
2. Click the arrow next to Open With to expose the product menu.
3. Choose either Adobe Acrobat or Adobe Reader from the application menu.
4. Click the Change All button.
5. When asked if you want to change all similar documents, click Continue.

Safari browser preferences
1. Launch Safari and go to ’Preferences
2. In the 'Preferences' window click on 'Security' and then click on 'Website Settings' button under 'Internet plug-ins' 

3. Now select 'Adobe Reader' in the list of plugins.
   Under the option 'When visiting other Websites', in the drop down list select 'Allow Always' and click on 'Done'

*Note:* This will set the browser to use the 'Adobe Reader' plugin to view pdfs
Disable AdobePDFViewer plug-in
You must have root user privileges to change the Safari plug-ins. To display PDFs using the Safari PDF viewer, you must disable the Adobe PDF Viewer.

1. Quit Safari.

2. Log in as the root user. The root user privileges aren't enabled by default because the root user can change system files. For more information and instructions, see one of the following Apple documents: Enabling and using the "root" user in Mac OS X or OS X Mountain Lion: Enable and disable the root user.

3. Choose Go > Go To Folder.

4. Type /Library in the Go To The Folder field, and click Go.

5. Create a new folder in the Library folder, and name it Internet Plug-ins Disabled.

6. Open the Internet Plug-ins folder, and move both the AdobePDFViewer.plugin and the AdobePDFViewerNPAPI.plugin into the new Internet Plug-ins Disabled folder.
**Note:** If both AdobePDFViewer plug-ins are still in the Internet Plug-ins folder, drag them now to the trash. You may be asked for your name and password.

For more information, see the Apple Safari help topic [If you need to remove a plug-in](#).

**See also** [Configure browser to use the Adobe PDF plug-in](#)
Problems Reading Adobe PDF files

- If the PDF file does not load when you click on it, hold down the Ctrl (Control) key and click on it again.
- If the PDF file does not load while pressing the Ctrl key, click on Refresh. Then try holding down the Ctrl key and clicking again.

Adobe Reader Support Resources

The Wisconsin Department of Transportation does not provide support for the Adobe Reader. Should you encounter difficulties downloading, installing, configuring, or using the Adobe family of products, Adobe has established a detailed support site for addressing issues or problems.

- Adobe customer support
  http://www.adobe.com/support/index.html
FIRST TIME USERS

All PARS users
- The first time your organization accesses PARS, your bank account information must be entered into the system. Please refer to the ACH Account Maintenance, Initial Account Information section in this manual for step-by-step instructions.

ACH Account Maintenance
- Only PARS users designated with ACH authority have the ability to set-up and change bank account information. If you have questions regarding who has ACH authority for your organization, please contact your PARS coordinator.

  Note: Bank Account information must be entered before abstracts can be requested.

Employer Notification users only
- Employer Notification users should immediately enroll their drivers.
- Refer to the “Employer Notification” section for instructions on enrolling your drivers.
Access to PARS will be through our DMV data portal provided by Wisconsin Interactive Network LLC (WIN). PARS Portal website address: http://www.portal.wi.gov/register/
Click on the PARS link, and the following screen will appear:

1. Type User ID.
2. Type Password.
3. Click on Login.

Password Problems:

- Forgot your Wisconsin User ID or password?
- Use the underlined links highlighted in blue for help with account recovery. Account recovery is used to restore access to your account if you cannot remember your password or your Wisconsin User ID.
- You must know the answer to your secret question and you must have access to the e-mail address used on your WAMS account.
- A link provided in the e-mail is used to recover your account information. If you have forgotten what your user ID is, it will appear in parenthesis in the email you will receive.
Welcome Page

The PARS welcome screen reminds users that PARS is for authorized use only.

- Click on the Select Organization drop down arrow to select the appropriate organization if you have authority on behalf of multiple organizations.
- Click on OK.

Note: The Logoff link is available in the upper left-hand corner of every page. Click on Logoff to exit the system.
Main Menu

Select the transaction you want to do:

- Click on **DMV Abstract Requests** to request and print abstracts.
- Click on **Employer Notification System** to obtain a list of enrolled employees with recent activity on their driving record, and to access Fed Med Certification Activity. Employers may order driver record abstracts directly from the Employer Notification screen.
- Click on **ACH Account Maintenance** to set-up, or change bank account information, and also view transaction history reports. This option is available only for PARS users designated with ACH authority.
- Click on **Audit Report Selection** to run audit reports detailing account activity. This option is available only for PARS users designated with ACH/Audit Report authority.
- Click on **Next**.
ACH MAINTENANCE (BANK ACCOUNT INFO)

Only users designated with the ACH role have access to bank account information and account history reports.

If your organization has a debit block on your account, you will need to obtain our company ID to provide to your financial institution. To request our company ID number, you can contact DMV Revenue Accounting at any of the following phone numbers:

- (608) 266-7253
- (608) 267-2345
- (608) 266-2612

On the PARS Main Menu screen:

- Click on **ACH/Bank Account Maintenance**.
- Click on **Next**.
The Bank Account screen appears.

- Click **Add** to add a bank account.
The Add a Bank Account screen appears.

- Type **Bank Name**.
- Click to select **Checking** or **Savings** Account Type.
- Type **Routing Number**.
- Type **Account Number**.
- Type **Account Number** a second time to verify.
- Click on **Add Bank Account** to add account.
- Click on **Cancel** to cancel transaction.
The Routing Number is located between the |: |: symbols and is always 9 digits for a U.S. check. See the next page for samples.

Before entering your bank routing number, please verify the correct number with your financial institution. It is also important to change the routing number and account number if your business changes financial institutions.

On personal checks:

On business checks:
The Bank Account screen appears with the added account in the list.

- Click on the appropriate button to select another function, or
- Click on **Return** to go back to the PARS Main Menu.

**Adding an Additional Bank Account**

On the Bank Account screen:

- Click **Add** to add a bank account.
The Add a Bank Account screen appears.
- Type Bank Name.
- Click to select Checking or Savings Account Type.
- Type Routing Number.
- Type Account Number.
- Type Account Number a second time to verify.
- Click on Add Bank Account to add account.
- Click on Cancel to cancel transaction.

The Bank Account screen appears with the added account in the list.
- Click on the appropriate button to select another function, or
- Click on Return to go back to the PARS Main Menu.
Bank Account Changes

Select primary account

On the Bank Account screen:
- Click **radio button in front of account**.
- Click **Make Primary** to make selected account the primary account.
- The Status in the right-hand column reflects the new primary bank account.
- Click on the appropriate button to select another function, or
- Click on **Return** to go back to the PARS Main Menu.
Remove Bank Account

On the Bank Account screen:
- Click radio button in front of account.
- Click Remove to remove selected account.

The Remove Bank Account Confirmation warning appears.
- Click on Remove to remove account.
• Click on **Cancel** to cancel transaction.

The Bank Account screen appears.
• Click on the appropriate button to select another function, or
• Click on **Return** to go back to the PARS Main Menu.
On the Bank Account screen:

- Click radio button in front of account.
- Click View Transaction History.
The Account Transaction History screen appears.

- Type **beginning date** in the From field.
- Type **ending date** in the To field.
- Click on **Retrieve Transactions** to retrieve transactions during the specified period.
- **Settlement Date:** The date the funds were debited from your account.
- **Reference Number:** The driver license number for the driver abstract generated OR the VIN/plate number for the vehicle abstract generated, unless no record was found using the search criteria entered.
- **Amount:** Dollar amount debited.
- **Reference Explanation:** Details search criteria submitted if no record was found.
- Click on **Cancel** to cancel transaction.
On the PARS Main Menu screen:

- Click on **Transaction Audit Report**.
- Click on **Next**.

The Audit Report will allow authorized users to run detailed reports of account history. Only users designated with the ACH role or Audit Report role have access to audit reports.
The Audit Report screen appears.

- Type **beginning date** in the From field.
- Type **ending date** in the To field.
- Click on **Retrieve Transactions** to retrieve transactions during the specified period.
- **Date/Time:** Details the date and time of each driver abstract request. The time appears in military format.
- **Requested By:** Indicates the name of the PARS user that requested the driver record abstract.
- **Driver Name:** Provides the name of person on the driver abstract, or the VIN number.
- **Search DID/Name:** Details the search criteria submitted that was entered by the PARS user to request the driver abstract, or vehicle abstract.
- Click on **Return** to return to the Main Menu.
DMV ABSTRACT REQUESTS

On the PARS Main Menu screen:

• Click on DMV Abstract Requests.
• Click on Next.

Note: Users that are not participating in the Employer Notification program and do not have ACH authority will proceed directly to the DMV Abstract Requests page.
Driver or Vehicle Abstracts

On the Order Abstract request screen:

- Choose the type of abstract you want to request
- Click on Main Menu if you want to return to the previous screen.

*Note:* Users that are not participating in both Driver Record and Vehicle Record request options will not see this screen.
Order a Driver Abstract

The Order Abstract Request screen appears.

- Type **Wisconsin Driver License#** in the Enter Driver License Number field (do not use spaces or dashes).

**OR:**
- If you **do not** have a driver license#:
  - Type **First Name**. Tab.
  - Type **Middle Initial**. Tab.
  - Type **Last Name**. Tab.
  - Type **Sex** (F or M). Tab.
  - Type **Birth Date** (mm/dd/yyyy).
  - Click on **Purchase an Abstract** to continue processing, or
  - Click on **Main Menu** to cancel transaction.

For **record requests using Name, Sex, and Date of Birth**: Enter the complete name. The middle initial is required if it appears on the DMV data records.

Requesting driver records with incomplete or inaccurate information will result in incurring a fee with a "No Customer Match" abstract being generated.

**Note:** You cannot enter both the driver license number and name, sex, date of birth on the same inquiry search. We recommend searching by driver license number whenever possible.
The Adobe PDF dialog box appears.

- To view or print Driver Record Abstract:
  - Click on [Adobe PDF].
  - If you want to print the document, follow printing instructions based on your system’s set-up for Adobe Acrobat documents.
  - Close Adobe window.
  OR
  - Click on Previous Page to return to the Order Abstract screen.
  OR
  - Click on Return to Main Menu to go the PARS Main Menu screen.

**Note:** If you forget to print an abstract, or experience computer problems while ordering an abstract, you can order the same abstract again (on the same day) and you will not be charged more than one time.

Please call (608) 266-2353, if you have a question on the information contained on the driver abstract.
Vehicle Records may be searched by entering only one of four different types of information.

- **Vehicle Identification Number (VIN)**
  - Type the entire VIN, use a zero (0) instead of the letter “O”
  - VINs vary in length from 1 to 21 alpha/numeric characters

- **License Plate Number**
  - Type the entire plate number with no spaces or dashes between the digits even if they appear on the plate; do not use “O” but instead use a zero (0). Dealer, Tribal and Apportioned plates are not viewable with this program.
  - When entering a license plate for a vehicle that has a weight sticker, do not enter the weight sticker as part of the plate number
  - Select the license plate type if you know it; adding this information will reduce the number of records returned by the system

*Note:* When reviewing a list of plates or vehicles to select you will notice a license plate “Status” will be included. This status does not reflect if the license plate is expired. “Valid” indicates the plate still belongs to the registered owner and has not been cancelled or reported stolen. Even if the license plate is not associated to a vehicle, the “Status” will still reflect “Valid” if it has not been cancelled, reported stolen or has expired.
• Business or Organization Name – “Non-Individual”
  • Type the business name as close to its official title as possible including “INC” or “LLC” if applicable
  • Most DMV records do not contain punctuations; enter “INC” instead of “Inc.”
• Individual name
  • Type the correct spelling of the last and first name
  • Type a middle initial when it is known

There are additional fields in the individual name area. Entering more information in these additional fields will help reduce the number of records returned for your search.

Note: You cannot enter information in more than one area of criteria, e.g. you cannot enter a VIN and license plate number or a license plate number and a customer name. You must choose one of the four areas.

Once you have entered your search criteria, verify the information is accurate.
  • Click on “Purchase an Abstract” to proceed, or
  • Click on “Main Menu” to return to the program option choices

Important: When the “Purchase an Abstract” button is selected your account will be charged a $5 search fee. One of the following will appear:
  • A list of customers from which to choose
  • The record for which you were searching
  • A pop-up screen indicating “No matching record found for the information entered”

When you receive a list to select a specific record, you will not be charged an additional fee for the first abstract. You may return to the list by clicking on the “Previous Page” button to select another customer or plate to purchase an additional abstract. If you return to the “New Search” screen without selecting an abstract your account is still charged a $5 fee.
When entering a Vehicle Identification Number (VIN) or License Plate Number you will usually receive an abstract directly. The abstract will be preceded by a pop-up screen that will give you the option of opening the record or saving it to a specific location on your computer. We recommend you save the abstract in case there is difficulty with your printer or you need to refer to it for additional information.

If you choose “Cancel” on this screen you will still be charged the $5 search fee.

When entering a Non-Individual Name or a Customer Name you may receive a list of customer records from which to choose. Review the list for the record matching your request. The list will contain the following information:

- Name
- Gender (individual only)
- Age (individual only)
- Address: Street, city, state, zip code and county
Select a record. The next screen will contain the customer record information and a list of vehicles associated with this customer.

<table>
<thead>
<tr>
<th>Owner Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Identifiers</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Primary Address</strong></td>
</tr>
<tr>
<td><strong>Details</strong></td>
</tr>
</tbody>
</table>

![Vehicle Details]

The vehicles associated with this customer will display the:

**Title status:**
- Valid – Currently titled to the customer listed above
- History – Title has been transferred to someone else or the vehicle has been recorded as junked.

**Registration Status:**
- Valid – Plate is still owned by the customer listed above; this is not an indication of whether the plate is current or expired.
- History – Plate has been cancelled, reported as stolen or destroyed.

**Role:**
- Own – Owner on record

*Note:* See the DMV Abstract Manual for an explanation of the different statuses and roles listed.

Select the “Purchase” button to view the vehicle’s abstract.
- If the vehicle has a History status and you click on the “Purchase” button, the abstract you receive:
  - Will be for the current owner of the vehicle if the vehicle was sold
  - The historical title if the vehicle was junked.
**Duplicate Records**

When entering the VIN or a license plate number, the vehicle abstract will appear unless there is a duplicate record for the same entry. A temporary plate may have the same license plate number as a Sesquicentennial plate or a light truck plate may have the same number as a semi-trailer plate. If this occurs, a list will appear identifying the plate type for you to select an abstract.

If a multiple VIN record exists, you will receive a message to contact the Vehicle Records Section for assistance.

Please call (608) 261-2583 for the Vehicle Information Section if you have a question on the information contained on the vehicle abstract.

*Note:* See the online Interpreting Public DMV Abstracts Manual for a list of the plate type abbreviations and their corresponding names.
EMPLOYER NOTIFICATION PROGRAM OVERVIEW

Employer Notification is an optional program for PARS participants. Employer Notification provides employers with current information regarding the driving record of their enrolled employees. Employers may enroll any employee whose employment responsibilities include the operation of any motor vehicle. Wisconsin Statutes 343.245 authorizes this program.

Employer Notification allows participants to create and maintain their own roster of employed drivers. The system is designed to have participants logon and check for employee driving activity. As detailed in the following pages, the system will identify all enrolled drivers with recent activity on their driving record and enable the purchase of their driving record abstract. Activity should be monitored on a regular basis, as determined by your particular business needs.

As a courtesy reminder, the PARS system will automatically send an e-mail each Monday morning to the designated PARS Agreement Coordinator if there has been recent activity on one or more drivers and an abstract has not yet been requested. Participants will only receive an e-mail if there has been recent activity and a driving record has not yet been requested.

We encourage PARS participants not to solely rely on these e-mails. E-mail delivery can be disrupted by elements beyond the control of DOT, including firewalls, spam filters, and suspended or disabled e-mail accounts.

What Triggers Employer Notifications?

Records will update when an event is added or changed:

- WI Accident Date
- Accident Severity
- Violation Date
- Conviction Date
- Charge Code
- MPH Over
- Minor in Vehicle
- Operating Class
- Violation Directive
- OOS Violation Date
- OOS Conviction Date
- OOS Charge Code
- OOS Operating Class
- OOS Violation Directive
- Withdrawal Effective Date
- Withdrawal Release Date
- Withdrawal Charge Code
- Length of Withdrawal
- H endorsement due - Notifies employer 60 days prior to H endorsement renewal date.
- School Bus Follow-up - Initial/Next - no charge
Records will update when an event is added:

- OOS Accident
- OOS Withdrawal
- Moved to another state
- Product Notations (Out-of-Service Withdrawals only)

**Triggers Related to Fed Med**

- New or updated accident (WI or Out of State)
- New or updated trackable, non-confidential violation (WI or Out of State)
- New or updated non-confidential withdrawal (WI or Out of State)
- New moved out of state entry
- New or updated H” - Hazmat restriction
- New or updated 51” - Intrastate restriction
- New or updated K” - Interstate restriction
- New CDL Self Certification
- New product notation 63 - 24 hour out of service
- School Bus Medical Follow-up
- Fed Med - MEDC - Medical Certificate Follow-up (Restriction expiring in 10 days, 60 days to med certificate expiration)
- Fed Med - MEDS - Medical Certification Status (Not Certified)
- Tier change
- Med cert notification:
  - 60 day (expiring in 60 days)
  - 0 day (expired today - not medically certified)
  - 10 day (now VTsed)

**Additional information:**

- If a withdrawal, violation, or restriction is added to the driver record, the employer is notified. If DOT then removes it, the notification is still made to the employer.
On the PARS Main Menu screen:
- Click on **Employer Notification Program**.
- Click on **Next**.
The Employee Notification System screen appears.

- **Employee Enrollment** – use to add, remove, or review employees in the Employer Notification Program. Driver license numbers must be used when adding or removing employees from the Employee Enrollment list.

- **Employee Activity** – provides a list identifying all enrolled employees with recent activity on their Driver Record. This will provide a list of employees with new convictions, withdrawals, accidents, etc.

- **Fed Med Certification Activity** – provides a list identifying all enrolled employees with recent activity that relates to their medical certification (Fed Med card or tier). This will provide a list of employees with Fed Med cards that are about to expire or when there is a change in tier. Employers are able to upload Fed Med Cards through this function.

- **Order Abstract** – use to order a driver abstract directly from the Employee Notification System screen.
Employee Enrollment

On the Employee Notification System screen:

- Click on Employee Enrollment.
- Click on Continue to continue processing, or
- Click on Cancel to cancel transaction and return to PARS Main Menu.
Add Employee to Notification List

The Employee Enrollment screen appears.
- Click on Add Employee to Notification List.
- Click on Continue to continue processing, or
- Click on Cancel to cancel transaction.

The Add Employee screen appears.
- Type Wisconsin Driver License# in the Enter Driver License Number field (do not use spaces or dashes). Note: If the customer had a previous driver license number due to a name change or date of birth correction, the current driver license number will appear on the Add Employee Confirmation screen.
- Click on Next to continue processing, or
- Click on Cancel to cancel transaction.
The Add Employee Confirmation screen appears.

- **Verify that this is the correct employee.**
- Click on **Confirm to Add Employee** to continue processing, or
- Click on **Cancel** to cancel transaction.

- Click on the box for **Check to Purchase an Abstract**, and you will be able to order an abstract as you add each employee.
The Adobe PDF dialog box appears.

- To view or print Driver Record Abstract:
  
  - Click on .
  
  - If you want to print the document, follow printing instructions based on your system’s set-up for Adobe Acrobat documents.
  
  - Close Adobe window.

OR

- Click on Previous Page to return to the Employee Enrollment screen.

OR

- Click on Return to Main Menu to go the PARS Main Menu screen.

Note: If you forget to print an abstract, or experience computer problems while ordering an abstract, you can order the same abstract again (on the same day) and you will not be charged more than one time.

Please call (608) 266-2353, if you have a question on the information contained on the driver abstract.
Error messages when adding employees

This indicates your account is not allowing drivers to be enrolled that do not have a Commercial Driver License. Call PARS Support if you wish to have your account setting changed to allow Class D (regular) drivers.

- Click on **OK**.
- You will return to the Add Employee screen.

The above error message indicates an employee has already been enrolled.

- Click on **OK**.
- You will return to the Add Employee screen.

The above error message indicates no driver license can be found for the number entered. The number was either entered incorrectly or the driver license number does not exist.

- Click on **OK**.
- You will return to the Add Employee screen.
Remove Employee from Notification List

On the Employee Enrollment screen:
- Click on Remove Employee from Notification List.
- Click on Continue to continue processing, or
- Click on Cancel to cancel transaction.

*Note:* This should be done when an employee is no longer employed by your agency. Failure to remove the employee will result in notifications continuing for this person.

The Delete Employee screen appears.
- Type Wisconsin Driver License# in the Enter Driver License Number field (do not use spaces or dashes).
- Click on Next to continue processing, or
- Click on Cancel to cancel transaction.
The Delete Employee Confirmation screen appears.

- **Verify that this is the correct employee.**
- Click on **Confirm to Remove from List** to continue processing, or
- Click on **Cancel** to cancel transaction.

The Successfully Deleted Employee(s) dialog box appears.

- Click on **OK**. You will return to the Delete Employee screen.
View List of all Employees Enrolled

On the Employee Enrollment screen:
  • Click on View List of All Employees Enrolled.
  • Click on Continue to continue processing, or
  • Click on Cancel to cancel transaction.

If no employees have been enrolled yet, you will receive the following error message:

The Employee Enrollment List appears.

The Employee Enrollment List displays the name and driver license number of every employee currently enrolled in the system. Employees may also be deleted or added using this screen. Driver record abstracts may also be ordered directly from this page.
Note: The employee enrollment list can be printed directly from this screen. Click on the Show All button and then Select the print function on your Internet browser.
Order Abstracts from Employee Enrollment List

On the Employee Enrollment List:

- Click on **Purchase Abstract button** to purchase and print an abstract from this screen.
Delete Employee from Employee Enrollment List

On the Employee Enrollment List:
- Click on **Delete** check box in front of each employee you wish to remove from the enrollment.
- Click on **Remove Employee(s) from list**.

The Delete Employee Confirmation screen appears:
- Click on **Confirm to Remove from List** to remove the employee.
- An “X” appears under the Delete column by the employee who was removed. The entry will be removed entirely upon exiting this screen.
- Click on **Cancel** to cancel transaction and return to the Employee Enrollment List.
Add Employee from Employee Enrollment List

On the Employee Enrollment List:

- Click on **Add Employee** button.
- The Add Employee screen appears. See “Add employee to notification list” section for details on adding an employee.
Employee Activity

On the Employee Notification System screen:
- Click on Employee Activity.
- Click on Continue to continue processing, or
- Click on Cancel to cancel transaction and return to PARS Main Menu.

Employee Activity provides a list identifying all enrolled employees with recent activity on their Driver Record. This provides a list of employees with new convictions, withdrawals, accidents, etc.
The Employee Activity screen appears.

- Click on **Purchase Abstract** to request an abstract.
- A red asterisk (*) will appear on the left-hand Abstract Ordered column after requesting the abstract.

**Note:** Selected employees will no longer appear on this screen the next time you run Employee Activity.

**Note:** Employees will remain listed until an abstract is purchased.
School bus medical follow-ups are generated when a driver with a school bus endorsement has a medical requirement that needs to be met. The notification appears 60-days before the school bus medical due date. The notification will not disappear until after the due date, even if the driver has complied with the requirement.

It is the employer’s choice whether or not to purchase a driver record when a school bus follow-up notification appears. If the driver does not comply with the requirements, their school bus endorsement will be cancelled and a new notification will be generated for the cancel.
Fed Med Certification Activity

On the Employee Notification System screen:
- Click on **Fed Med Certification Activity**.
- Click on **Continue** to continue processing, or
- Click on **Cancel** to cancel transaction and return to PARS Main Menu.
## The Federal Medical Certification Activity Screen

### Tier Information

<table>
<thead>
<tr>
<th>Notification Reviewed</th>
<th>DID Number</th>
<th>Name</th>
<th>Notification Type</th>
<th>Current Tier</th>
<th>Current Certification</th>
<th>Fed Med Exp Date</th>
<th>Notify Date</th>
<th>Enter and Upload Fed Med Certificate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>J5205527326001</td>
<td>JONES, MICHAEL L</td>
<td>CDL SELF-CERTIFICATION</td>
<td>TIER 1</td>
<td>CERTIFIED</td>
<td>2014-12-11</td>
<td>2013-12-26</td>
<td>Fed Med</td>
</tr>
<tr>
<td></td>
<td>J5205527326001</td>
<td>JONES, MICHAEL L</td>
<td>MEDICAL CERTIFICATION STATUS</td>
<td>TIER 1</td>
<td>CERTIFIED</td>
<td>2014-12-11</td>
<td>2013-12-26</td>
<td>Fed Med</td>
</tr>
<tr>
<td></td>
<td>Z3356209405202</td>
<td>ZZDOTNR, NICOLE TEST</td>
<td>K RESTRICTION</td>
<td>TIER 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Clicking on Tier Information will open up the window to look like this:

### Tier Information

- For Tier 1 drivers you may enter and upload Fed Med card and waiver information.
- For Tier 2-4 drivers you may not enter or upload Fed Med card or waiver information.
- For more information/definitions of the Tiers, click [here](#).

- You can choose to Sort By Name OR Sort By Med Exp Date by clicking on this button
- Clicking Return will take you to the previous screen
- This screen shows you:
  - The DID number for the employee listed
  - The Employees Name
  - The Notification Type. Some possible Notifications are:
    - K RESTRICTION: added/removed on license. K=No CMV Operation Interstate, unless excepted
    - 51 RESTRICTION: added/removed on license. 51=No CMV Operation Intrastate, unless excepted
    - MEDICAL CERTIFICATE FOLLOW-UP: 60 day follow-up notification letter sent saying the Fed Med will expire in 60 days (only occurs for Tier 1)
    - MEDICAL CERTIFICATION STATUS: Fed Med Certification Status change (only occurs for Tier 1)
    - CDL SELF-CERTIFICATION: New or change to a self certification (tier)
Once you have determined to either purchase an abstract or not, you can click on the “Notification Reviewed” button to remove this person from the Notification.

The Employee’s Current Tier

- Tier 1: Non-excepted interstate – Employee needs to provide a valid Fed Med card to DMV.
- Tier 2: Excepted interstate – Employee does not need a Fed Med card. Employee is engaged in interstate commerce and subject to one of the exceptions listed on the Help Page.
- Tier 3: Non-excepted intrastate – Employee needs a valid Fed Med card to drive a commercial vehicle.
- Tier 4: Excepted intrastate – Employee does not need a Fed Med card. Employee is engaged in intrastate commerce and subject to one of the exceptions as follows:
  - Tow trucks (if requested by a federal, state or local officer to move a wrecked or disabled vehicle).
  - Grandfathered (held valid CDL since July 29, 1996, that has not been revoked).
  - Wisconsin diabetes exemption to the Fed Med card.
  - Wisconsin vision exemption to the Fed Med card.
  - All exceptions listed on the Help Page under Tier 2, only completed within intrastate commerce.

- Current Certification: Not-Certified means the driver can’t operate under Tier 1, they may still have a valid Fed Med card.
- Fed Med Exp Date: Expiration date of the current Fed Med card on system with the DMV.
- Notify Date
- Upload Fed Med Certificate (Tier 1 only)
Uploading a Fed Med Certificate

Clicking on the Fed Med button will produce the following screen:

All information must be added. Once information is added, click on the submit button.

The Fed Med Card will need to be uploaded. Click on Ok to close the message box.
Clicking on Instructions for uploading medical forms will provide step by step directions on uploading.

**EMPLOYER NOTIFICATION SYSTEM**

**Medical Examiner's Certificate Entry**

Laura processing on behalf of PARS USER SUPPORT

**Please upload medical forms for ZZZDOTFEDMED, FEDMED.**

**Instructions for uploading medical forms**

To upload a Fed Med card or Medical Examiner's Certificate (and any other documents, like a waiver if this person has one) to the Department of Transportation, do the following:

- Use a scanner to scan any Fed Med card or Medical Examiner's Certificate (and any other documents, like a waiver if this person has one) and save the images to your computer. Please review that the images are clear and legible. Acceptable file formats are JPG, TIF, GIF, PNG and PDF and the file size must not be larger than 5MB.
- For your Medical Examiner's Certificate or Fed Med card, click on the Browse... button under “Medical Certificate”, navigate to where you saved the image, select the file and click Open. If you have a 2nd Medical Examiner’s Certificate or Fed Med card image to upload, click the Add Another Image... button to add another file.
- Once you have selected your file(s) to upload, click the Upload Medical Files button. Once the upload is complete, a page will display indicating that your medical forms have been uploaded.

**Medical Certificate**

Browse...

Follow the directions for scanning and saving the documentation. Then click on Browse to search for the documentation. Once found, choose the documents to upload, and click on Upload Medical Files:

**Medical Certificate**

Browse...

Add Another Image...
Once the documentation has been uploaded the following screen will show, offering you an option to print:

**EMPLOYER NOTIFICATION SYSTEM**

**Confirmation**

Lauraf processing on behalf of PARS USER SUPPORT

The upload of the medical forms was successful. Please wait 10 days for the Department of Transportation to process this information.

Name: FEDMED Z2D0TFEDMED
Certification Tier: Tier 1 - CMV interstate/intestate operation allowed if Fed Med is valid
Fed Med Status: CERTIFIED
Fed Med Expiration Date: 03-01-2014

Click the Return button to go back or the Print button to print this page.

If the employee has already keyed and uploaded card, you will see the following screen with a warning box notifying you this has already been uploaded.

**Message from webpage**

The Fed Med information for this person has already been entered/uploaded by this person. You may only review this information. You may not update this record or upload medical files for this person.

For Questions on Fed Med Certifications please call: 608-267-2290
Order Abstract

On the Employee Notification System screen:

- Click on **Order Abstract**.
- Click on **Continue** to continue processing, or
- Click on **Cancel** to cancel transaction and return to PARS Main Menu.

The Order Abstract screen appears.

- Type **Wisconsin Driver License#** in the Enter Driver License Number field (do not use spaces or dashes).
- Click on **Purchase an Abstract** to continue processing, or
- Click on **Cancel** to cancel transaction.

Requesting driver records with inaccurate information will result in incurring a fee with a "No Customer Match" abstract being generated.
Click on **Logoff** link found in the upper left-hand corner of most screens in this program.

The Signed off message appears.